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	UNIT STANDARD 116940 :
Use a Graphical User Interface (GUI)-based spreadsheet application to solve a given problem 

		SPECIFIC OUTCOME 1 



	Prepare and produce a spreadsheet to provide a solution to a given problem. 



		ASSESSMENT CRITERION 1 



	An outline solution is developed to meet the requirements of a given brief. 



	ASSESSMENT CRITERION 2 



	The spreadsheet produced addresses the given problem. 



	Level 3
	6 Credits

		SPECIFIC OUTCOME 2 



	Adjust settings to customise the view and preferences of the spreadsheet application to suite the solution created for the given problem. 



		ASSESSMENT CRITERION 1 



	Toolbar menus are switched off and on. 



	ASSESSMENT CRITERION 2 



	The view of the spreadsheet is enlarged and made smaller. 



	ASSESSMENT CRITERION 3 



	The way that the spreadsheet is viewed is changed. 



	ASSESSMENT CRITERION 4 



	Cells are frozen to prevent scrolling. 



	ASSESSMENT CRITERION RANGE 



	Row, column, both



	ASSESSMENT CRITERION 5 



	The default file location is changed. 



	ASSESSMENT CRITERION 6 



	A user name is added to the file.





	
	

		SPECIFIC OUTCOME 3 



	Work with multiple worksheets to suite the solution to the given problem. 



		ASSESSMENT CRITERION 1 



	The purpose of using multiple worksheets within one spreadsheet file are explained with examples. 



	ASSESSMENT CRITERION 2 



	New worksheets are opened. 



	ASSESSMENT CRITERION RANGE 



	Minimum 3 worksheets.
 



	ASSESSMENT CRITERION 3 



	Worksheets are renamed in terms of their purpose within the solution to the given problem. 



	ASSESSMENT CRITERION RANGE 



	Each worksheet to have a different name, with a purpose within the solution.
 

	ASSESSMENT CRITERION 4 



	Cells are manipulated between worksheets. 



	ASSESSMENT CRITERION RANGE 



	Cell range at least two of: 

  Cell, range of cells, entire columns, entire row, entire worksheet. 

Type of manipulation: 

  move, copy.
 

	ASSESSMENT CRITERION 5 



	A worksheet within a workbook (or spreadsheet) is deleted. 



	
	

		SPECIFIC OUTCOME 4 



	Apply formulae to worksheets to provide alternative solutions to the given problem. 

	OUTCOME RANGE 



	Formulae to include at least 3 of: 

  Addition(+), subtraction (-), multiplication (*), division (/), percentage (%). 






		ASSESSMENT CRITERION 1 



	Formulae are entered taking into consideration the natural order of operation. 



	ASSESSMENT CRITERION 2 



	Formulae are entered to deliberately change the natural order of operation. 



	ASSESSMENT CRITERION 3 



	Formula error messages are correctly interpreted and the formula corrected accordingly. 



	ASSESSMENT CRITERION 4 



	The difference between relative and absolute cell addressing is demonstrated by using it in a formula. 



	ASSESSMENT CRITERION 5 



	Data are changed to test possible solutions to the given problem without having to change formulae. 



	ASSESSMENT CRITERION 6 



	Scenarios are created that demonstrate different possible outcomes. 



	
	

		SPECIFIC OUTCOME 5 



	Apply simple built-in functions of the spreadsheet application to the given problem. 



		ASSESSMENT CRITERION 1 



	Functions are explained in terms of their purpose, use and construct. 



	ASSESSMENT CRITERION RANGE 



	At least one function to be used as an example.
 

	ASSESSMENT CRITERION 2 



	Simple Mathematical functions are applied to the given problem. 



	ASSESSMENT CRITERION RANGE 



	At least the following functions: 

  Sum a range, round to a specified number of decimals.
 

	ASSESSMENT CRITERION 3 



	Statistical functions are applied that achieve the anticipated result. 



	ASSESSMENT CRITERION RANGE 



	At least two of the following functions: 

  Average a range, count the number of cells that contain numbers, find the highest value in a range, find the lowest value in a range.



	
	

		SPECIFIC OUTCOME 6 



	Apply formatting to a spreadsheet applicable to the given problem. 



		ASSESSMENT CRITERION 1 



	Methods of automatically formatting a spreadsheet are explained. 



	ASSESSMENT CRITERION RANGE 



	Templates, styles, manual.
 



	ASSESSMENT CRITERION 2 



	A spreadsheet is created using a template. 



	ASSESSMENT CRITERION 3 



	Cells are formatted using styles. 



	ASSESSMENT CRITERION RANGE 



	Number, date, currency, percentage.
 



	ASSESSMENT CRITERION 4 



	Formats are copied between cells. 



	
	

		SPECIFIC OUTCOME 7 



	Use special effects to improve the presentation of the spreadsheet. 



		ASSESSMENT CRITERION 1 



	Text is centered across a cell range. 



	ASSESSMENT CRITERION 2 



	Orientation of text within a cell is changed. 



	ASSESSMENT CRITERION 3 



	A border is applied to cells and removed from cells. 



	ASSESSMENT CRITERION RANGE 



	Cell, range of cells, entire column, entire row.
 

	ASSESSMENT CRITERION 4 



	Fill (shading) is applied to cells and removed from cells. 



	ASSESSMENT CRITERION RANGE 



	Cell, range of cells, entire column, entire row.



	
	

		SPECIFIC OUTCOME 8 



	Evaluate a spreadsheet to comply with the given problem. 



		ASSESSMENT CRITERION 1 



	The spreadsheet is evaluated for compliance with a given problem, appropriate formatting, readability, legibility, presentation, accuracy, and data integrity. 



	ASSESSMENT CRITERION 2 



	The spreadsheet is modified if required and compliance with the brief is confirmed. 
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Introduction to Excel 2010
Excel 2010 is the spreadsheet software in the Microsoft 2010 Office Suite. It allows you to store, organize, and analyze numerical and text data. As one of the most used computer software programs for businesses today, mastering Microsoft Excel is an important skill that workers should have. It is no wonder that companies and businesses demand that their staff learn MS Excel so that they can stay competitive.
Here are some more uses of Microsoft Excel: 
· Create graph and chart
· import data from the web
· Data converter
· data analysis 
· Visualisation and 
· A host of other purposes to support financial decision and business transaction for end users and business professionals. 
Microsoft Excel is frequently used by accountants, business consultants and everyday people. Without Excel, many people would have difficulty performing basic duties.
I. Financials
When a person has to create a business plan, he will likely use Microsoft Excel to draw up the financials, including the income statement, balance sheet and cash flow statement.
II. Complicated Formulas
Microsoft Excel is used as a calculator. It comes with a variety of formulas, some that are very complex and hard to solve on paper.
III. Organization and Storage
Excel is very effective at organizing and storing important financial data in a clean, easy-to-read format. The sheet is organized as a group of cells that hold each piece of data so that the user can find information quickly.
IV. Time Saver
In the past, accountants used paper ledgers to record financial data. This was a very time-consuming process-especially when it came to doing manual calculations and writing out information. Microsoft Excel spreadsheets help save the user a significant amount of time because everything is typed and automated.
V. Budgeting
Excel is also important because of its function as a simple personal and business budgeting tool. It is useful for listing bills, tracking income and expenditures, and setting financial goals.





[bookmark: _Toc251883216][bookmark: _Toc251946805][bookmark: _Toc360115152]Lesson 1 - Setting Up Your Excel Environment

[image: Excel 2010]

Excel is a spreadsheet program that allows you to store, organize, and analyze information. In this lesson, you will learn your way around the Excel 2010 environment, including the new Backstage view, which replaces the Microsoft Button menu from Excel 2007.  You will also learn how to use and modify the Ribbon and the Quick Access Toolbar, and how to create new workbooks and open existing ones. 

Exploring the Excel Environment
Before you begin creating spreadsheets in Excel, you may want to set up your Excel environment and become familiar with a few key tasks and features such as how to minimize and maximize the Ribbon, configure the Quick Access toolbar, switch page views, and access your Excel options.

NOTE: The Excel 2010 interface is very similar to Excel 2007. There have been some changes that we will review later in this lesson, but if you are new to Excel, first take some time to learn how to navigate an Excel workbook.

The Ribbon and the Quick Access Toolbar are where you will find the commands you need to do common tasks in Excel. If you are familiar with Excel 2007, you will find that the main difference in the Excel 2010 Ribbon is that commands such as Open and Print are now housed in Backstage view.
[image: Excel 2007 Initial Screen]
The Ribbon:
The Ribbon contains multiple tabs, each with several groups of commands. You can add your own tabs that contain your favorite commands.
Certain programs, such as Adobe Acrobat Reader, may install additional tabs to the ribbon. These tabs are called Add-ins.

[image: Overview of the Ribbon]
To Customize the Ribbon:
You can customize the ribbon by creating your own tabs that house your desired commands. Commands are always housed within a group, and you can create as many groups as you need to keep your tabs organized. In addition, you can even add commands to any of the default tabs, as long as you create a custom group within the tab.
1. Right-click the Ribbon and select Customize the Ribbon. A dialog box will appear.
[image: Right-clicking the Ribbon to customize it]
2. Click New Tab. A new tab will be created with a new group inside it.
3. Make sure the new group is selected.
4. Select a command from the list on the left, then click Add. You can also drag commands directly into a group.
5. When you are done adding commands, click OK.
If you do not see the command you want, click on the Choose commands drop-down box and select All Commands.
[image: Displaying All Commands]
To Minimize and Maximize the Ribbon:
The Ribbon is designed to be responsive to your current task and easy to use, but if you find it is taking up too much of your screen space, you can minimize it.
1. Click the arrow in the upper-right corner of the Ribbon to minimize it.
[image: Overview of the Ribbon]
2. To maximize the Ribbon, click the arrow again.
When the Ribbon is minimized, you can make it reappear by clicking on a tab. However, the Ribbon will disappear again when you are not using it.
To Add Commands to the Quick Access Toolbar:
The Quick Access Toolbar is located above the Ribbon, and it lets you access common commands no matter which tab you are on. By default, it shows the Save, Undo, and Repeat commands. You can add other commands to make it more convenient for you.
1. Click the drop-down arrow to the right of the Quick Access Toolbar.
2. Select the command you wish to add from the drop-down menu. To choose from more commands, select More Commands.
[image: Customize The Quick Access Toolbar]
To Zoom In and Out:
· Locate the zoom bar in the bottom, right corner.
· Left-click the slider and drag it to the left to zoom in and to the right to zoom out.

[image: Quickly zoom in and out on your Excel worksheets]
To Scroll Horizontally in a Worksheet:
· Locate the horizontal scroll bar in the bottom, right corner.
· Left-click the bar and move it from left to right.

To Change Page Views:
Excel 2010 by default displays the newly added Worksheet in Normal View. But using Excel Options you can change the default view for the new worksheet. To change the default view in Microsoft Excel 2010

· Click the File menu and then the Options link.
· In the General Options, navigate to When creating new workbooks

[image: image]

· Click the Default view for new sheets.
· This would display the Normal View, Page Break View and Page Layout View. Now set your preferred view as the default View.

[image: image]

· Click the Ok to save and confirm the changes.

[bookmark: _Toc360115153]Activity 1
· Open Excel.
· Practice using the Zoom tool.
· Minimize and maximize the Ribbon.
· Click the Microsoft Office Button and review the menu options.
· Add two commands to the Quick Access toolbar.
· Switch on and off the ribbon
· Continue to explore the Excel environment.
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[image: http://www.fanhow.com/images/c/c7/Open_an_OpenDocument_Spreadsheet_in_Excel_2010-01.png]
Excel files are called workbooks. Each workbook holds one or more worksheets (also known as "spreadsheets"). You will need to know how to insert text and numbers into Excel workbooks to be able to use it to calculate, analyze, and organize data. In this lesson, you will learn how to create a new workbook, insert and delete text, navigate a worksheet, and save an Excel workbook
Your First Workbook
To Create a New, Blank Workbook:
1. Click the File tab. This takes you to Backstage view.
2. Select New.
3. Select Blank workbook under Available Templates. It will be highlighted by default.
4. Click Create. A new, blank workbook appears in the Excel window.

[image: Creating a new workbook]
When you first open Excel, the software opens to a new, blank workbook.
To save time, you can create your document from a template, which you can select under available Templates. We will talk more about this in a later lesson.

The Cell:

Cells are the basic building blocks of a worksheet. Cells can contain a variety of content such as text, formatting attributes, formulas, and functions.

Each rectangle in a worksheet is called a cell. A cell is the intersection of a row and a column for example Row 4, Column D as shown in the diagram below.

[image: Row 4, Column D]

Each cell has a name, or a cell address based on which column and row it intersects. The cell address of a selected cell appears in the Name box. Here you can see that C5 is selected.

[image: Cell address]

To Select a Cell:
1. Click on a cell to select it. When a cell is selected you will notice that the borders of the cell appear bold [image: Cursor] and the column heading and row heading of the cell are highlighted.

2. Release your mouse. The cell will stay selected until you click on another cell in the worksheet.

You can also navigate through your worksheet and select a cell by using the arrow keys on your keyboard.

To Select Multiple Cells:

1. Click and drag your mouse until all of the adjoining cells you want are highlighted.

[image: Selecting multiple cells]

2. Release your mouse. The cells will stay selected until you click on another cell in the worksheet.

Cell Content:

Each cell can contain its own text, formatting, comments, formulas, and functions.
· Text: Cells can contain letters, numbers, and dates.
· Formatting attributes: Cells can contain formatting attributes that change the way letters, numbers, and dates are displayed. For example, dates can be formatted as MM/DD/YYYY or Month/D/YYYY.
· Comments: Cells can contain comments from multiple reviewers.
· Formulas and Functions: Cells can contain formulas and functions that calculate cell values. For example, SUM(cell 1, cell 2...) is a formula that can add the values in multiple cells.

To Insert Text:
1. Click on a cell to select it.
2. Enter content into the selected cell using your keyboard. The content appears in the cell and in the formula bar. You also can enter or edit cell content from the formula bar.

[image: Inserting content]


To Edit or Delete Text:
1. Select the cells which contain content you want to delete.
2. Click the Clear command on the ribbon. A dialog box will appear.
3. Select Clear Contents.

[image: Clearing cell contents]

You can also use your keyboard's Backspace key to delete content from a single cell or Delete key to delete content from multiple cells.

To Save the Workbook:
1. Click the File tab.
2. Select Save As or Save
· Save As allows you to name the file and choose a location to save the spreadsheet. Choose Save As if you'd like to save the file for the first time or if you'd like to save the file as a different name. 
· Select Save if the file has already been named

[image: Clicking Save As]

3. Select the location where you wish to save the workbook.
4. Enter a name for the workbook and click Save.

You can save a workbook in many ways, but the two most common are as an Excel Workbook, which saves it with a 2010 file extension, and as an Excel 97-2003 Workbook, which saves the file in a compatible format so people who have earlier versions of Excel can open the file. 
[bookmark: _Toc360115155]Activity 2			
· Open Excel.
· Create a new, blank workbook.
· Practice entering text into cells.
· Practice deleting text using the Backspace and Delete keys.
· Navigate through the sheet using the Tab key.
Save the spreadsheet.
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Freeze Panes Using the Active Cell
The ability to freeze specific rows or columns in your worksheet can be a very useful feature in Excel. It is called freezing panes. When you freeze panes, you select rows or columns that will remain visible all the time, even as you are scrolling. This is particularly helpful when working with large spreadsheets.

To Freeze Rows:
1. Select the row below the rows that you want frozen. For example, if you want rows 1 and 2 to always appear at the top of the worksheet even as you scroll, then select row 3.
[image: Selecting row 3]
2. Click the View tab.
3. Click the Freeze Panes command. A drop-down menu appears.
4. Select Freeze Panes.
[image: Selecting the Freeze Panes command from the View tab]
5. A black line appears below the rows that are frozen in place. Scroll down in the worksheet to see the rows below the frozen rows.

[image: Rows 1 and 2 are frozen]
To Freeze Columns:
1. Select the column to the right of the columns you want frozen. For example, if you want columns A & B to always appear to the left of the worksheet even as you scroll, then select column C.
[image: Selecting column C]
2. Click the View tab.
3. Click the Freeze Panes command. A drop-down menu appears.
4. Select Freeze Panes.
5. A black line appears to the right of the frozen area. Scroll across the worksheet to see the columns to the right of the frozen columns.
[image: Columns A and B are frozen]
To Unfreeze Panes:
1. Click the View tab.
2. Click the Freeze Panes command. A drop-down menu appears.
3. Select Unfreeze Panes. The panes will be unfrozen and the black line will disappear.
[image: Selecting the Unfreeze Panes command from the View tab]
Changing the default file location
When you first start using Microsoft Excel 2010, Excel wants to save files in the Documents (Windows 7 or Vista) or the My Documents folder (Windows XP) under your user name on your hard drive. So, for example, the directory path of the default folder where Excel 2010 automatically saves new workbook files on a computer running Windows 7 or Vista is
C:\Users\username\Documents
However, the directory path of the default folder where Excel 2010 automatically saves new workbook files on a computer running Windows XP is
C:\Documents and Settings\username\My Documents
The generic Documents or My Documents folder may not be where you want new workbooks you create to be automatically saved.
To change the default file location to another folder on your computer, follow these steps:
1. Click the File tab and then click Options. The Excel Options dialog box appears.
2. Click the Save tab. The Save options appear in the right pane.
3. Click in the Default File Location text box.
[image: image0.jpg]
4. Edit the existing path or replace it with the path to another folder in which you want all future workbooks to be saved.
5. Click OK.
The Excel Options dialog box closes. The next time you save a new workbook file, it will be saved to the default file location you specified - unless you change the folder location in the Save As dialog box.
[bookmark: _Toc360115157]Activity 3			
· Open a large spreadsheet 
· Practice freezing and unfreezing rows and columns. 
· Change the default location of your file.
· Add a user name to your file
· Save changes
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[image: Lesson 17]
It is important that you know how to effectively manage your worksheets. By default, three worksheets appear in each new workbook. In this lesson, you will learn how to name, add, delete, group, and ungroup worksheets. 
Reasons for multiple worksheets in one spreadsheet
There are many reasons why you would do it. For example you could have a business with different offices in different regions. The head office might put figures from the regional offices onto different sheets, like their amounts of sales, and then have one sheet which totals them all up. They could then see the individual offices and the totals all in one sheet, rather than having them in separate files. That is more efficient and saves space and allows you to do lots of calculations from figures on the different sheets. It is also better than have the different regional figures all together in one single sheet, as it would make it harder to control and navigate through. They can lay things out in the exact same cells in each sheet, making calculations easier to do. So the total sales in each sheet could be in cell D54 and knowing that they are all in D54 on each sheet can make it easier to do calculations to total them on another sheet. 

Another reason might be to have things that are loosely related to each other all in different sheets in one spreadsheet. Using a business example again, they could have sales in one sheet, purchases in another, wages in another, stock levels in another and so on. All of these are aspects of their business. There would be some connections between some parts, so they could have calculations that might involve their sales and their stock levels. It can be handier to have them together in several sheets, rather than in separate files. 
[bookmark: _Toc251883241][bookmark: _Toc254953308]Naming Worksheets
When you open an Excel workbook, there are three sheets by default and the default name on the worksheet tabs are Sheet1, Sheet2 and Sheet3. These are not very informative names. Excel 2010 allows you to define a meaningful name for each worksheet in a workbook so you can quickly locate information.
To Rename a Worksheet:
1. Right-click the worksheet tab you want to rename. The worksheet menu appears.
2. Select Rename.

[image: Selecting the Rename command]

3. The text is now highlighted by a black box. Type the name of your worksheet.

[image: Renaming the worksheet]

4. Click anywhere outside of the tab. The worksheet is renamed.

[image: Renamed worksheet]

5. Choose Rename from the menu that appears. The text is highlighted by a black box.

OR
· Click the Format command in the Cells group on the Home tab.
· Select Rename Sheet. The text is highlighted by a black box. 
· Type a new name for the worksheet.
· Click off the tab. The worksheet now assumes the descriptive name defined.
[bookmark: _Toc251883242][bookmark: _Toc254953309]
Inserting Worksheets

You can change the setting for the default number of worksheets that appear in Excel workbooks. To access this setting, go into Backstage view and click on Options. . You also have the ability to insert new worksheets if needed, while you are working.
To Insert a New Worksheet:
· Click on the Insert Worksheet icon. A new worksheet will appear.

[image: Inserting a new worksheet]


Deleting Worksheets
Any worksheet can be deleted from a workbook, including those that have data in it. Remember, a workbook must contain at least one worksheet. 
1. Select the worksheets you want to delete.
2. Right-click one of the selected worksheets. The worksheet menu appears.
3. Select Delete. The selected worksheets will be deleted from your workbook.
[image: Deleting a worksheet]
To Copy a Worksheet:
1. Right-click the worksheet you want to copy. The worksheet menu appears.
2. Select Move or Copy.
[image: Selecting the Move or Copy command]
3. The Move or Copy dialog box appears. Check the Create a copy box.
[image: Checking the Create a copy box]
4. Click OK. Your worksheet is copied. It will have the same title as your original worksheet, but the title will include a version number, such as "January (2)".
[image: Copied worksheet]
To Move a Worksheet:
1. Click on the worksheet you want to move. The mouse will change to show a small worksheet icon [image: Mouse change].
2. Drag the worksheet icon until a small black arrow [image: Mouse change] appears where you want the worksheet to be moved.
[image: Moving a worksheet]
3. Release your mouse and the worksheet will be moved.
[image: Moved worksheet]
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Grouping and Ungrouping Worksheets
You can work with each worksheet in a workbook individually, or you can work with multiple worksheets at the same time. Worksheets can be combined together into a group. Any changes made to one worksheet in a group will be made to every worksheet in the group.
To Group Worksheets:
1. Select the first worksheet you want in the group.
[image: Selecting the first worksheet to group]
2. Press and hold the Ctrl key on your keyboard.
3. Select the next worksheet you want in the group. Continue to select worksheets until all of the worksheets you want to group are selected.
[image: Selecting the first worksheet to group]
4. Release the Ctrl key. The worksheets are now grouped. The worksheet tabs appear white for the grouped worksheets.
While worksheets are grouped, you can navigate to any worksheet in the group and make changes that will appear on every worksheet in the group. If you click on a worksheet tab that is not in the group, however, all of your worksheets will become ungrouped. You will have to regroup them.
To Ungroup All Worksheets:
1. Right-click one of the worksheets. The worksheet menu appears.
2. Select Ungroup. The worksheets will be ungrouped.

[bookmark: _Toc360115159]Activity 4
Use the Inventory workbook or any workbook you choose to complete this challenge.
· Rename Sheet1 to January, Sheet2 to February and Sheet3 to March.
· Insert two worksheets and name them April and May.
· If necessary, move the April and May worksheets so they are immediately following the March sheet.
· Use the Grouping feature so that all the sheets contain the same information as the January sheet.
· Copy the April worksheet 
· Move the January worksheet to where the March worksheet is.
· Delete the May sheet.
· Freeze rows 1 and 2 on the January sheet.
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[image: Lesson 17]
Excel can be used to calculate and analyze numerical information; however, you will need to know how to write formulas to maximize Excel's capabilities. A formula is an equation that performs a calculation using values in the worksheet. In this lesson you will learn how to create simple formulas using mathematical operators such as the addition, subtraction, multiplication, and division signs.
Simple Formulas
To Create a Simple Formula that Adds Two Numbers:
· Click the cell where the formula will be defined (C5, for example).
· Type the equal sign (=) to let Excel know a formula is being defined.
· Type the first number to be added (e.g., 1500)
· Type the addition sign (+) to let Excel know that an add operation is to be performed.
· Type the second number to be added (e.g., 200) 
· Press Enter or click the Enter button on the Formula bar to complete the formula.
[image: Simple Addition Formula]
To Create a Simple Formula that Adds the Contents of Two Cells:
· Click the cell where the answer will appear (C5, for example). 
· Type the equal sign (=) to let Excel know a formula is being defined.
· Type the cell number that contains the first number to be added (C3, for example).
· Type the addition sign (+) to let Excel know that an add operation is to be performed.
· Type the cell address that contains the second number to be added (C4, for example). 
· Press Enter or click the Enter button on the Formula bar to complete the formula.
[image: Formula with Cell Reference]
To Create a Simple Formula using the Point and Click Method:
1. Select the cell where the answer will appear (B4, for example).

[image: Selecting cell B4]

2. Type the equal sign (=).
3. Click on the first cell to be included in the formula (A3, for example).

[image: Clicking cell A3]
4. Type the operator you need for your formula. For example, type the multiplication sign (*).
5. Click on the next cell in the formula (B3, for example).

[image: Clicking cell B3]
6. Press Enter. The formula will be calculated and the value will be displayed in the cell.

To Create a Simple Formula that Multiplies the Contents of Two Cells:
· Select the cell where the answer will appear (E32, for example).
· Type the equal sign (=) to let Excel know a formula is being defined.
· Click on the first cell to be included in the formula (C9, for example) or type a number. 
· Type the multiplication symbol (*) by pressing the Shift key and then the number 8 key. The operator displays in the cell and Formula bar.
· Click on the next cell in the formula or type a number (12, for example).
· Press Enter or click the Enter button on the Formula bar to complete the formula.
. 
[image: Multiplication Formula]
To Create a Simple Formula that Divides One Cell by Another:
· Click the cell where the answer will appear.
· Type the equal sign (=) to let Excel know a formula is being defined.
· Click on the first cell to be included in the formula.
· Type a division symbol. The operator displays in the cell and Formula bar.
· Click on the next cell in the formula.
· Enter or click the Enter button on the Formula bar to complete the formula.

To Create a Formula Using Cell References:
1. Select the cell where the answer will appear (B3, for example).
[image: Selecting cell B3]
2. Type the equal sign (=).
3. Type the cell address that contains the first number in the equation (B1, for example).
[image: Entering a formula in B3]
4. Type the operator you need for your formula. For example, type the addition sign (+).
5. Type the cell address that contains the second number in the equation (B2, for example).
[image: Entering a formula in B3]
6. Press Enter. The formula will be calculated and the value will be displayed in the cell.
[image: Result in B3]

If you change a value in either B1 or B2, the total will automatically recalculate.
[image: Result in B3]

To Edit a Formula:
1. Click on the cell you want to edit.
2. Insert the cursor in the formula bar and edit the formula as desired. You can also double-click the cell to view and edit the formula directly from the cell.
3. When finished, press Enter or select the Enter command[image: Cursor].
[image: Edit a formula]
4. The new value will be displayed in the cell.
[image: Result]
If you change your mind, use the Cancel command [image: Cursor] in the formula bar to avoid accidentally making changes to your formula.
Formula Error Values
If Excel 2010 can't properly calculate a formula that you enter in a cell, the program displays an error value in the cell as soon as you complete the formula entry. Excel uses several error values, all of which begin with the number sign (#).


Excel's error values:
The following table shows Excel's error values along with the meaning and the most probable cause for its appearance. To remove an error value from a cell, you must figure out what's wrong with the formula and fix it.

	Error Value
	Meaning
	Causes

	#DIV/0
	Division by zero
	The division operation in your formula refers to a cell that contains the value 0 or is blank.

	#N/A
	No value available
	Technically, this is not an error value but a special value that you can manually enter into a cell to indicate that you don't yet have a necessary value.

	#NAME?
	Excel doesn't recognize a name
	This error value appears when you incorrectly type the range name, refer to a deleted range name, or forget to put quotation marks around a text string in a formula.

	#NULL!
	You specified an intersection of two cell ranges whose cells don't actually intersect
	Because a space indicates an intersection, this error will occur if you insert a space instead of a comma (the union operator) between ranges used in function arguments.

	#NUM!
	Problem with a number in the formula
	This error can be caused by an invalid argument in an Excel function or a formula that produces a number too large or too small to be represented in the worksheet.

	#REF!
	Invalid cell reference
	This error occurs when you delete a cell referred to in the formula or if you paste cells over the ones referred to in the formula.

	#VALUE!
	Wrong type of argument in a function or wrong type of operator
	This error is most often the result of specifying a mathematical operation with one or more cells that contain text.



Using the error alert button:
When a formula yields an error value (other than #N/A) in a cell, Excel displays a green triangular error indicator in the upper-left corner of the cell and an alert options button appears to the left of that cell when you make it active.
If you position the mouse pointer on that options button, a ScreenTip appears, describing the nature of the error value. Also, a drop-down button appears to its right that you can click to display a drop-down menu with the following options:
· Help on This Error: Opens an Excel Help window with information on the type of error value in the active cell and how to correct it.
· Show Calculation Steps: Opens the Evaluate Formula dialog box, where you can walk through each step in the calculation to see the result of each computation.
· Ignore Error: Bypasses error checking for this cell and removes the error alert and Error options button from it.
· Edit in Formula Bar: Activates Edit mode and puts the insertion point at the end of the formula on the Formula bar
· Error Checking Options: Opens the Formulas tab of the Excel Options dialog box, where you can modify the options used in checking the worksheet for formula errors.
If you are dealing with a worksheet that contains many error values, you can use the Error Checking button in the Formula Auditing group on the Ribbon's Formulas tab to locate each error.


[bookmark: _Toc360115161]Activity 5
Use the Budget or any Excel workbook you choose to complete this challenge.
· Write a simple addition formula.
· Write a simple subtraction formula using the point and click method.
· Write a simple multiplication formula using cell references.
· Write a simple division formula.
· Identify and rectify errors
· Edit a formula using the formula bar.
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[image: Lesson 17]
Excel is a spreadsheet application and is intended to be used to calculate and analyze numerical information such as household budgets, company finances, inventory, and more. To do this, you need to understand formulas.

In this lesson, we’ll discuss complex formulas that use multiple mathematical operators, and that use absolute and relative references.
Complex Formulas
Complex Formulas Defined
Simple formulas have one mathematical operation. Complex formulas involve more than one mathematical operation.
Simple Formula: =2+2 
Complex Formula: =2+2*8
To calculate complex formulas correctly, you must perform certain operations before others. This is defined in the order of operations.
The Order of Operations
The order of mathematical operations is very important. If you enter a formula that contains several operations, Excel knows to work those operations in a specific order. The order of operations is:
1. Operations enclosed in parenthesis
2. Exponential calculations (to the power of)
3. Multiplication and division, whichever comes first
4. Addition and subtraction, whichever comes first
A mnemonic that can help you remember this is Please Excuse My Dear Aunt Sally (P.E.M.D.A.S).

Example 1
Using this order, let us see how the formula 20/(8-4)*8-2 is calculated in the following breakdown:
[image: Formula Breakdown]

Example 2
3+3*2=? 
Is the answer 12 or 9? Well, if you calculated in the order in which the numbers appear, 3+3*2, you'd get the wrong answer, 12. You must follow the order of operations to get the correct answer.
To Calculate the Correct Answer:
1. Calculate 3*2 first because multiplication comes before addition in the order of operations. The answer is 6.
2. Add the answer obtained in step #1, which is 6, to the number 3 that opened the equation. In other words, add 3 + 6.
3. The answer is 9.
4. Before moving on, let's explore some more formulas to make sure you understand the order of operations by which Excel calculates the answer.
	4*2/4
	Multiply 4*2 before performing the division operation because the multiplication sign comes before the division sign. The answer is 2.

	4/2*4 
	Divide 4 by 2 before performing the multiplication operation because the division sign comes before the multiplication sign. The answer is 8.

	4/(2*4) 
	Perform the operation in parentheses (2*4) first and divide 4 by this result. The answer is 0.5.

	4-2*4 
	Multiply 2*4 before performing the subtraction operation because the multiplication sign is of a higher order than the subtraction sign. The answer is -4.


[bookmark: _Toc251883226][bookmark: _Toc254953288][bookmark: _Toc360115163]Creating Complex Formulas
Excel automatically follows a standard order of operations in a complex formula. If you want a certain portion of the formula to be calculated first, put it in parentheses.
Example of How to Write a Complex Formula:
In this example, we will use cell references in addition to actual values, to create a complex formula that will add tax to the nursery order.
1. Click the cell where you want the formula result to appear (for example, F11).
2. Type the equal sign (=).
3. Type an open parenthesis, then click on the cell that contains the first value you want in the formula (for example, F4).
4. Type the first mathematical operator (for example, the addition sign).
5. Click on the cell that contains the second value you want in the formula (for example, F5), and then type a closed parenthesis.
6. Type the next mathematical operator (for example, the multiplication sign).
7. Type the next value in the formula (for example, 0.055 for 5.5% tax).

[image: Row 4, Column D]

8. Click Enter to calculate your formula. The results show that $2.12 is the tax for the nursery order.
[image: Result in F11]

Working with Cell References

In order to maintain accurate formulas, it is necessary to understand how cell references respond when you copy or fill them to new cells in the worksheet.
Excel will interpret cell references as either relative or absolute. By default, cell references are relative references. When copied or filled, they change based on the relative position of rows and columns. If you copy a formula (=A1+B1) into row 2, the formula will change to become (=A2+B2).

Absolute references, on the other hand, do not change when they are copied or filled and are used when you want the values to stay the same.

Relative References
Relative references can save you time when you are repeating the same kind of calculation across multiple rows or columns.

In the following example, we are creating a formula with cell references in row 4 to calculate the total cost of the electric bill and water bill for each month (B4=B2+B3). For the upcoming months we want to use the same formula with relative references (C2+C3, D2+D3, E2+E3, etc.) For convenience, we can copy the formula in B4 into the rest of row 4 and Excel will calculate the value of the bills for those months using relative references.

To Create and Copy a Formula Using Relative References:
1. Select the first cell where you want to enter the formula (for example, B4).
[image: Selecting cell B4]

2. Enter the formula to calculate the value you want (for example, add B2+B3).
[image: Entering formula into B4]

3. Press Enter. The formula will be calculated.
[image: Result in B4]
4. Select the cell you want to copy (for example, B4) and click on the Copy command from the Home tab.

5. Select the cells where you want to paste the formula and click on the Paste command from the Home tab. (You may also drag the fill handle to fill cells.)
[image: Values calculated in C4:M4]

6. Your formula is copied to the selected cells as a relative reference (C4=C2+C3, D4=D2+D3, E4=E2+E3, etc.) and the values are calculated.

Absolute References
There may be times when you do not want a cell reference to change when copying or filling cells. You can use an absolute reference to keep a row and/or column constant in the formula.

An absolute reference is designated in the formula by the addition of a dollar sign ($). It can precede the column reference, the row reference, or both.
[image: Absolute Reference Chart]
 
In the below example, we want to calculate the sales tax for a list of products with varying prices. We will use an absolute reference for the sales tax ($B$1) because we do not want it to change as we are copying the formula down the column of varying prices.

To Create and Copy a Formula Using an Absolute Reference:

1. Select the first cell where you want to enter the formula (for example, C4)
[image: Selecting cell C4]

2. Click on the cell that contains the first value you want in the formula (for example, B4).

3. Type the first mathematical operator (for example, the multiplication sign).

4. Type the dollar sign ($) and enter the column letter of the cell you are making an absolute reference to (for example, B).
[image: Entering formula]

5. Type the dollar sign ($) and enter the row number of the same cell you are making an absolute reference to (for example, 1).

[image: Entering formula]

6. Press Enter to calculate the formula.
[image: Result in C4]

7. Select the cell you want to copy (for example, C4) and click on the Copy command from the Home tab.

8. Select the cells where you want to paste the formula and click on the Paste command from the Home tab. (You may also drag the fill handle to fill cells.)

[image: Values calculated in C5:C8]

9. Your formula is copied to the selected cells using the absolute reference (C5=B5*$B$1, C6=B6*$B$1, etc.) and your values are calculated.

[bookmark: _Toc360115164]Activity 6
Use the Inventory or any Excel workbook you choose to complete this challenge.
· Create at least one complex formula that uses the addition and division operations. 
· Create at least one complex formula that uses parentheses and a multiplication operation. 
· Create a complex formula that uses the multiplication and division operations.
· Create a formula that uses a relative reference
· Create a formula that uses an absolute reference. 
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[image: Lesson 17]
A function is a predefined formula that performs calculations using specific values in a particular order. While you may think of formulas as being short mathematical equations, like 2 + 2 or F2 * C2, they can actually be very lengthy and involve complex mathematical calculations. 

One of the key benefits of functions is that they can save you time since you do not have to write the formula yourself. For example, you could use an Excel function called Average to quickly find the average of a range of numbers or the Sum function to find the sum of a cell range.

In this lesson, you will learn how to use basic functions such as SUM and AVG, use functions with more than one argument, and how to access the other Excel 2010 functions. 
Basic Functions
The Parts of a Function:
Each function has a specific order, called syntax, which must be strictly followed for the function to work correctly.
Syntax Order:
1. All functions begin with the = sign. 
2. After the = sign define the function name (e.g., Sum). 
3. Then there will be an argument. An argument is the cell range or cell references that are enclosed by parentheses. If there is more than one argument, separate each by a comma. 
An example of a function with one argument that adds a range of cells, A3 through A9:
[image: Function With One Argument]
An example of a function with more than one argument that calculates the sum of two cell ranges:
[image: Function With Two Arguments]
Excel literally has hundreds of different functions to assist with your calculations. Building formulas can be difficult and time-consuming. Excel's functions can save you a lot of time and headaches.
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There are many different functions in Excel 2010. Some of the more common functions include:
Statistical Functions:
· SUM - summation adds a range of cells together.
· AVERAGE - average calculates the average of a range of cells.
· COUNT - counts the number of chosen data in a range of cells.
· MAX - identifies the largest number in a range of cells.
· MIN - identifies the smallest number in a range of cells.
Financial Functions:
· Interest Rates
· Loan Payments
· Depreciation Amounts
Date and Time functions:
· DATE - Converts a serial number to a day of the month
· Day of Week
· DAYS360 - Calculates the number of days between two dates based on a 360-day year
· TIME - Returns the serial number of a particular time
· HOUR - Converts a serial number to an hour
· MINUTE - Converts a serial number to a minute
· TODAY - Returns the serial number of today's date
· MONTH - Converts a serial number to a month
· YEAR - Converts a serial number to a year
You don't have to memorize the functions but should have an idea of what each can do for you.
To Create a Basic Function in Excel:
1. Select the cell where the answer will appear (F15, for example) 
2. Type the equal sign (=) and enter the function name (SUM, for example).
[image: Creating a SUM function]
3. Enter the cells for the argument inside the parenthesis.
[image: Adding cells to the function argument]
4. Press Enter and the result will appear.
Using AutoSum to select Common Functions:
[image: AutoSum command]The AutoSum command allows you to automatically return the results for a range of cells for common functions like SUM and AVERAGE.
1. Select the cell where the answer will appear (E24, for example).
2. Click on the Home tab.
3. In the Editing group, click on the AutoSum drop-down arrow and select the function you desire (Average, for example).

4. A formula will appear in the selected cell E24. If logically placed, AutoSum will select your cells for you. Otherwise, you will need to click on the cells to choose the argument you desire.
[image: AutoSum selects and dsiplays cell range]
5. Press Enter and the result will appear.
[image: Result]
The AutoSum command can also be accessed from the Formulas tab.
To Edit a Function:
· Select the cell where the function is defined.
· Insert the cursor in the formula bar.
· Edit the range by deleting and changing necessary cell numbers.
· Click the Enter icon.

To Calculate the Sum of Two Arguments:
The SUMIF function is used to add up the values in cells in a selected range that meet certain criteria.

[image: Excel SUMIF Function]The SUMIF function is used to add up the values in cells in a selected range that meet certain criteria. 

The syntax for the SUMIF function is: = SUMIF (Range, Criteria, Sum Range)
Range - the group of cells the function is to search.
Criteria - determines whether the cell is to be summed or not.
Sum Range - the data range that is summed if the first range meets the specified criteria. If this range is omitted, the first range is summed instead.

Example Using Excel's SUMIF Function:
1. Enter the following data into cells E1 to E6: 114, 165, 178, 143, 130, 165.
2. Enter the following data into cells F1 to F6: 10, 20, 30, 10, 20, 30.
3. Click on cell F7 - the location where the results will be displayed.
4. Click on the Formulas tab of the ribbon.
5. Choose Math and Trig from the ribbon to open the function drop down list.
6. Click on SUMIF in the list to bring up the function's dialog box. 
7. In the dialog box, click on the Range line.
8. Drag select cells E1 to E6 on the spreadsheet.
9. On the Criteria line in the dialog box, type "165".
10. Click on the SUM Range line.
11. Drag select cells F1 to F6 on the spreadsheet.
12. Click OK.
13. The answer 50 should appear in cell E7. Since the criteria of equaling 165 is met by only two cells - E2 and E6, only their corresponding cells - F2 and F6 are summed. The sum of 20 and 30 is 50.

14. When you click on cell E7 the complete function = SUMIF (D1: D6, 165, E1: E6) appears in the formula bar above the worksheet.

To Calculate the Average of a Range of Data:
· Select the cell where you want the function to appear.
· Click the drop-down arrow next to the AutoSum command.
· Select Average.
· Click on the first cell to be included in the formula.
· Left-click and drag the mouse to define a cell range 
· Click the Enter icon to calculate the average.
[bookmark: _Toc360115167][bookmark: _Toc251883230][bookmark: _Toc254953293]How to find the maximum and minimum values
Launch Excel 2010 spreadsheet on which you want to find out Maximum and Minimum values. For instance let’s consider a student record spreadsheet containing fields; Names, Course, and Marks, as shown in screenshot below
[image: tablw]
First we will be creating Max Marks and Min Marks labels beneath the table.
[image: max min]
Now we will be finding out Maximum value out of Marks field, for this we will be writing MAX function in the adjacent cell of Max Marks.
The syntax of Max Marks is; =Max (number1, number2,…)
We will be writing it as; =MAX (C2:C11)
The argument C2:C11 is the location of cell where data is residing. It will yield the maximum value from the field Marks, as shown in the screenshot below.
[image: max value]
For finding out minimum values from the table we will be writing MIN function as; =MIN (C2:C11)
It will yield the minimum value from the Marks field.
[image: min value]
The MAX and MIN function only evaluate if there is only numeric values present in the datasheet, if you want to include logical values and get them evaluated, then you will need to use MAXA and MINA functions.
To Insert a Function from the Function Library:
1. Select the cell where the answer will appear (I6, for example)
2. Click on the Formulas tab.
3. From the Function Library group, select the function category you desire. In this example, we will choose Date & Time.
4. Select the desired function from the Date & Time drop-down menu. We will choose the NETWORKDAYS function to count the days between the order date and receive date in our worksheet.
[image: Function Library Date & Time category ]
5. The Function Arguments dialog box will appear. Insert the cursor in the first field and then enter or select the cell(s) you desire (G6, for example).
[image: Selecting cell for the Start-date field]
6. Insert the cursor in the next field and then enter or select the cell(s) you desire (H6, for example).
[image: Selecting cell for the End_date field]
7. Click OK and the result will appear. Our results show that it took 5 days to receive the order.
[image: Result]
Using the Insert Function command:
1. Select the cell where the answer will appear (A27, for example)
2. Click on the Formulas tab and select the Insert Function command.
3. The Insert Function dialog box will appear.
4. Type a description of the function you are searching for and click Go.
5. Review the results to find the function you desire. Then click OK
6. The Function Arguments dialog box will appear. Insert the cursor in the first field and then enter or select the cell(s) you desire
7. Insert the cursor in the next field and then enter or select the cell(s) you desire. You may continue to add additional arguments if needed.
8. Click OK and the result will appear

[bookmark: _Toc360115168]Activity 7
Use the Inventory workbook or any workbook you choose to complete this challenge.
· Use a SUM function to calculate the sum of one argument.
· Use the AVG function to calculate the sum of a range of cells.
· Use the maximum and minimum functions to calculate maximum and minimum values.
· Explore the other Excel 2010 functions.
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[image: Lesson 16]
In Excel 2010, you have many templates that can save you a lot of time. A template is a pre-designed spreadsheet that you can use to create new spreadsheets with the same formatting and predefined formulas. With templates, you don't need to know how to do the math, or even how to write formulas- these are already integrated into the spreadsheet. 
In this lesson, you will learn how to create a new workbook with a template, as well as basic information about how templates work in Excel 2010.
Templates
Excel allows you to create new workbooks using templates, or a predefined pattern. Several templates are preloaded in Excel and others are located on Microsoft Office Online. 
To Create New Workbooks Using Templates:
1. Open Excel. Click the File tab to go to Backstage view
2. Select New. The Available Templates pane appears.
3. Click Sample templates to choose a built-in template, or select an Office.com template category to download a template. In this example, we will download a template from Office.com.
[image: Available Templates pane]
4. Thumbnail images of the templates you have to choose from appear in the center. A larger preview appears on the right.

5. Select the desired template, then click Download to open it. (If using a Sample template, Download will be replaced by Create.)

[image: Opening a template]

6. A new workbook will appear using the template you chose.
[image: New workbook utilizing a template]

Use caution when downloading Office.com templates. Some of them are uploaded by people not affiliated with Microsoft, and Microsoft cannot guarantee that those templates are free from viruses or defects.

[bookmark: _Toc360115170]Activity 8
· Open Excel.
· View the templates on your computer.
· View several of the template categories on Microsoft Office Online.
· Select a template.
· Download the template.
· Enter your data into the template.
· Save and close the workbook.
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[image: Excel 2010]
Worksheets that have not been formatted are often very difficult to read. Fortunately, Excel gives you many tools that allow you to format text and tables in various ways. One of the ways you can format your worksheet so that it is easier to work with is to apply different types of alignment to text.

In this lesson, you will learn how to change the colour and style of text and cells; align text; and apply special formatting to numbers and dates.
[bookmark: _Toc360115172]Formatting Cells
To Change the Font:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the font command on the Home tab. The font drop-down menu appears.
3. Move your mouse over the various fonts. A live preview of the font will appear in the worksheet.
[image: Changing the font]
4. Select the font you want to use.
To Change the Font Size:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the font size command on the Home tab. The font size drop-down menu appears.
3. Move your mouse over the various font sizes. A live preview of the font size will appear in the worksheet.
[image: Changing the font size]
4. Select the font size you want to use.
You can also use the Grow Font and Shrink Font commands to change the size.
[image: The Grow Font and Shrink Font Commands]
To Use the Bold, Italic, and Underline Commands:
1. Select the cells you want to modify.
2. Click the Bold (B), Italic (I), or Underline (U) command on the Home tab.
[image: The Bold, Italic, and Underline Commands]
To Add a Border:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the Borders command on the Home tab. The border drop-down menu appears.
[image: Adding a border]
3. Select the border style you want to use.
You can draw borders and change the line style and colour of borders with the Draw Borders tools at the bottom of the Borders drop-down menu.
To Change the Font Colour:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the font colour command on the Home tab. The colour menu appears.
3. Move your mouse over the various font colours. A live preview of the colour will appear in the worksheet.
[image: Adding a font color]
4. Select the font colour you want to use.
Your colour choices are not limited to the drop-down menu that appears. Select More Colours at the bottom of the menu to access additional colour options.
To Add a Fill Colour:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the fill colour command on the Home tab. The colour menu appears.
3. Move your cursor over the various fill colours. A live preview of the colour will appear in the worksheet.
[image: Adding a fill color]
4. Select the fill colour you want to use.
To Change Horizontal Text Alignment:
1. Select the cells you want to modify.
2. Select one of the three horizontal Alignment commands on the Home tab.
· Align Text Left: Aligns text to the left of the cell.
· Center: Aligns text to the center of the cell.
· Align Text Right: Aligns text to the right of the cell.

[image: Aligning Text Left]
To Change Vertical Text Alignment:
1. Select the cells you want to modify.
2. Select one of the three vertical Alignment commands on the Home tab.
· Top Align: Aligns text to the top of the cell.
· Middle Align: Aligns text to the middle of the cell.
· Bottom Align: Aligns text to the bottom of the cell.
[image: Top Aligning Text] 
By default, numbers align to the bottom-right of cells and words or letters align to the bottom-left of cells.
Formatting Numbers and Dates
One of the most useful features of Excel is its ability to format numbers and dates in a variety of ways. For example, you might need to format numbers with decimal places, currency symbols ($), percent symbols (%), etc.
To Format Numbers and Dates:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the Number Format command on the Home tab.
[image: Accessing Number Format commands]
3. Select the number format you want. For some number formats, you can then use the Increase Decimal and Decrease Decimal commands (below the Number Format command) to change the number of decimal places that are displayed.
To Modify Column Width:
1. Position your mouse over the column line in the column heading so that the white cross [image: Cursor] becomes a double arrow [image: Double-arrow].
[image: Positioning mouse over the column line]
2. Click and drag the column to the right to increase the column width or to the left to decrease the column width.
[image: Increasing the column width]
3. Release the mouse. The column width will be changed in your spreadsheet.
[image: Increasing the column width]
To Set Column Width with a Specific Measurement:
1. Select the columns you want to modify.
2. Click the Format command on the Home tab. The format drop-down menu appears.
3. Select Column Width.
[image: Increasing the column width]
4. The Column Width dialog box appears. Enter a specific measurement.
[image: Increasing column width to 258 pixels]
5. Click OK. The width of each selected column will be changed in your worksheet.
Select AutoFit Column Width from the format drop-down menu and Excel will automatically adjust each selected column so that all the text will fit.
To Modify the Row Height:
1. Position the cursor over the row line so that the white cross [image: Cursor] becomes a double arrow [image: Double-arrow].
[image: Positioning the mouse over the row line]
2. Click and drag the row downward to increase the row height or upward decrease the row height.
[image: Increasing the row height]
3. Release the mouse. The height of each selected row will be changed in your worksheet.
[image: Increased row height]
To Set Row Height with a Specific Measurement:
1. Select the rows you want to modify.
2. Click the Format command on the Home tab. The format drop-down menu appears.
3. Select Row Height.
4. The Row Height dialog box appears. Enter a specific measurement.
[image: Increasing row height to 60 pixels]
5. Click OK. The selected rows heights will be changed in your spreadsheet.
Select AutoFit Row Height from the format drop-down menu and Excel will automatically adjust each selected row so that all the text will fit.
Wrapping Text and Merging Cells
If a cell contains more text than can be displayed, you can choose to wrap the text within the cell or merge the cell with empty, adjoining cells. Wrap text to make it display on multiple lines of the cell. Merge cells to combine adjoining cells into one larger cell.
To Wrap Text:
1. Select the cells with text you want to wrap.
[image: Selecting cells to wrap]
2. Select the Wrap Text command on the Home tab.
[image: Selecting the Wrap Text command]
3. The text in the selected cells will be wrapped in your worksheet.
[image: Cells with wrapped text]
If you change your mind, re-click the Wrap Text command to unwrap the text.
To Merge Cells Using the Merge and Center Command:
1. Select the cells you want to merge together.
[image: Selecting A1:D1 (A1, B1, C1, D1)]
2. Select the Merge & Center command on the Home tab.
[image: Selecting the Merge & Center command]
3. The selected cells will be merged and the text will be centered.
[image: A1 after merging with A1:I1]
If you change your mind, re-click the Merge & Center command to unmerge the cells.
To Access More Merge Options:
Click the drop-down arrow next to the Merge & Center command on the Home tab. The merge drop-down menu appears.
· Merge & Center: Merges selected cells into one cell and centers the text.
· Merge Across: Merges each row of selected cells into larger cells. This command is useful if you are merging content across multiple rows of cells and do not want to create one large cell.
· Merge Cells: Merges selected cells into one cell.
· Unmerge Cells: Unmerges the selected cells.
[image: Accessing more Merge options]
Formatting a cell
Excel 2010 provides a variety of number formats that you can apply to the values (numbers) you enter in a worksheet to make the data easier to interpret. These number formats include currency, accounting, percentage, date, time, fraction, and scientific, as well as a few special formats.
How you enter values into an Excel 2010 worksheet determines the type of number format that they get. Here are some examples:
· Currency: If you enter a financial value complete with the dollar sign and two decimal places, Excel assigns a Currency number format to the cell along with the entry.
· Percentages: If you enter a value representing a percentage as a whole number followed by the percent sign without any decimal places, Excel assigns to the cell the Percentage number format that follows this pattern along with the entry.
· Dates: If you enter a date (dates are values, too) that follows one of the built-in Excel number formats, such as 11/10/09 or 10-Nov-09, the program assigns a Date number format that follows the pattern of the date.
Even if you are a really good typist and prefer to enter each value exactly as you want it to appear in the worksheet, you still use number formats to make the values that are calculated by formulas match the others you enter. Excel applies a General number format to all the values it calculates as well as any you enter that don’t follow one of the other Excel number formats. The General format drops all leading and trailing zeros from entries. This makes it very hard to line up numbers in a column on their decimal points. The only cure is to format the values with another number format.
[image: Numbers with decimals don’t align when you choose General formatting.]

Numbers with decimals don’t align when you choose general formatting.
You can assign a number format to a group of values before or after you enter them. Formatting numbers after you enter them is often the most efficient way to go because it’s just a two-step procedure:
1. Select the cell(s) containing the value(s) you want to format.
2. Select the desired number format 


Apply a number format via the Number group on the Home tab or the Format Cells dialog box.
Copying formatted cells
Use the Format Painter button on the Home tab of the Excel 2010 Ribbon to save time when copying formatting between cells in your worksheets. You also can use Format Painter to quickly copy the width of one column to another column. Just select the heading of the first column, click the Format Painter button, and then click the heading of the column where you want to apply the column width.
Double-click the Format Painter tool (instead of clicking it once) to lock it in so you can paint additional cells without having to reselect the tool. Click the Format Painter tool again to unlock it.
1. Select a cell or range containing the formatting you want to copy.
You can select a single cell or range of cells with the desired formatting.
2. On the Home tab, in the Clipboard group, click the Format Painter button (the yellow-bristled paintbrush).
The mouse pointer changes to a white plus sign with a paintbrush. A marquee appears around the selected cell.
3. Click in or drag across the cell(s) you want to format.
[image: image0.jpg]
Excel immediately applies formats such as font, size, colors, borders, and alignment.

[bookmark: _Toc360115173]Activity 9
Use the Inventory workbook or any workbook you choose to complete this challenge.
· Insert a row and centre-align the text.
· Insert a column and left-align the text.
· Use the merge and centre command to add a title row.
· Apply the wrapped text command to the entire table.
· Practice using the other features discussed in this lesson.




[bookmark: _Toc251883222][bookmark: _Toc251946810][bookmark: _Toc360115174]Lesson 10 - Working with Cells

[image: Excel 2010]
It is important to know how to move information from one cell to another in Excel. Learning the various ways will save you time and make working with Excel easier. Certain methods are more appropriate depending on how much information you need to move and where it will reside on the spreadsheet. In this lesson you will learn how to cut, copy, and paste, as well as drag and drop information.
Working with Cells
To Copy and Paste Cell Contents:
1. Select the cells you wish to copy.
2. Click the Copy command. The border of the selected cells will change appearance.

[image: Copying selected cells]
3. Select the cell or cells where you want to paste the content.
4. Click the Paste command. The copied content will be entered into the highlighted cells.

[image: Pasting selected cells]

To Cut and Paste Cell Content:
1. Select the cells you wish to cut.
2. Click the Cut command. The border of the selected cells will change appearance.
[image: Cutting selected cells]

3. Select the cells where you want to paste the content.
4. Click the Paste command. The cut content will be removed from the original cells and entered into the highlighted cells.
[image: Pasting selected cells]

To Drag and Drop Information:
1. Select the cells that you wish to move.
2. Position your mouse on one of the outside edges of the selected cells. The mouse changes from a white cross [image: Cursor] to a black cross with 4 arrows[image: Cursor].

[image: Positioning the mouse to drag and drop cells]

3. Click and drag the cells to the new location.

4. Release your mouse and the cells will be dropped there.
[image: Dropped cells]


To Use the Fill Handle to Fill Cells:
1. Select the cell or cells containing the content you want to use. You can fill cell content either vertically or horizontally.
2. Position your mouse over the fill handle so that the white cross [image: Cursor] becomes a black cross[image: Cursor].

[image: Positioning the mouse to use the fill handle] 

3. Click and drag the fill handle until all the cells you want to fill are highlighted.
4. Release the mouse and your cells will be filled.

[image: Filled cells]

Adding and removing borders:

You can separate or outline a cell or group of cells by applying borders (left, right, top or bottom) to the edges of cells. Border options can be found under the Borders button on the Font group on the Home Ribbon or under the Border tab of the Format Cells dialog box. The Format Cells dialog box contains additional border options such as line style and border colour.
To Apply Cell Borders
1. Select the cell or range of cells to which you want to apply borders.
2. Click the arrow on the Borders button on the Home Ribbon.
3. Select a Border style from the palette.

[bookmark: _Toc360115175]Activity 10
Use the Budget or any Excel workbook you choose to complete this challenge.
· Copy and paste information from one cell to another cell.
· Use the Cut command to remove information from one cell and then paste it into another cell.
· Use the fill handle to fill 2 or more cells.
· Drag and drop information from one place in the spreadsheet to another location.


























[bookmark: _Toc251883231][bookmark: _Toc251946814][bookmark: _Toc360115176]Lesson 11 – Evaluating the accuracy of a spreadsheet

The gold standard for professional data entry is to enter data not once, but twice. The two data sets are then compared, differences are examined and corrections are made. This is a “good practice” technique that will help you enter your data with fewer errors. An IBM programmer, Wilf Hey, coined a term in 1966; “Garbage in- Garbage out.”  Don’t enter garbage data. If you want any analysis of your data to be valid, your data itself must be valid. Although there are specific program designed for data entry, the ubiquitous Excel provides many data analysts a quit and cheap alternative. If you choose to use Excel, at least do it correctly. This example shows you how.
To use the Excel double data entry method, create two identical blank data entry spreadsheets, with only the labels at the top of the column as shown in the figure below. For this example, the first worksheet will be in the tab Sheet1 and the second (identical sheet) in Sheet2. Preparing the spreadsheet for data entry is discussed in the referenced paper by Elliott et al (2007).

[image: Double Data Entry1]

Data should then be entered into the spreadsheets by two different people. If it is impossible to use two different people, at least enter the data at two different sessions. Data records must be entered in the same order, so in this example, each person (ID) should be entered in order on the rows starting with row number 2. An example spreadsheet (Sheet1) with data entered is shown below.
[image: Double Data Entry 2]
For this example the following information is entered into Sheet2. You may notice that there are a few typos.
 
[image: Double Data Entry 3]
 
Once the data are entered into both spreadsheets, the procedure described here can be used to compare the two spreadsheets for differences.
If the two spreadsheets containing the entered data are not in the same worksheet file, copy the second spreadsheet and paste it into Sheet2 of the original worksheet. For this example to work, the spreadsheets must be in the same workbook, one in Sheet1 and the other in Sheet2.
To compare these two spreadsheets follow these steps:
1. If there is not already a Sheet3 tab at the bottom of your worksheet, insert a third worksheet (Sheet3) by right-clicking on the Sheet1 tab and selecting Insert. Name the spreadsheet Sheet3.
2. Copy the labels (row 1) from the Sheet1 worksheet to the Sheet3 worksheet.
3. In Sheet3 place the cursor in cell A2 and (carefully) enter the following Excel formula:
=IF(EXACT(SHEET1!A2,SHEET2!A2),0,SHEET1!A2&"/"&SHEET2!A2)
 

Briefly, this formula uses Excel’s “IF” statement to compare the entry in the first spreadsheet SHEET1!A2 to the entry in the second sheet SHEET2!A2 for an exact match. If the match is exact, the IF statement puts a 0 (zero) in the cell. If the two cells do not match, the SHEET1!A2&"/"&SHEET2!A2 statement puts the information from sheet1 followed by a slash and the information from sheet2 in the cell. You’ll see how this works as you continue the example…

Copy the Excel formula to all cells to compare in your worksheets (in this case from A2 to F5). One method of copying this formula in Excel is to place the cursor in cell A2 and press CTRL-C (Copy). Then highlight the cells from A2 to F5 and press CTRL-V (Paste). This copies the formula to all of the specified cells. The “difference” spreadsheet (Sheet3) looks like the one illustrated below.
 
[image: Double Data Entry 4]
 

Notice the cells in the difference spreadsheet. Cells containing a 0 indicate a match.  If the values between the two spreadsheets do not match, the cell displays the actual data values from the two sheets displayed so that the differences are apparent. For example, the digits for AGE in cell B3 are reversed on the two sheets (32 versus 23). Notice in the date comparison in cell D4 that date codes (33429/33430) are displayed rather than actual dates. Since these numbers are one digit apart it means that the dates on Spread1 and Spread2 are one day apart. The original spreadsheet contains the date as July 10, 1974 and the other spreadsheet contains it as July 11, 1974.
Using the information in the difference spreadsheet, you should refer to your original data entry documents. You or an arbitrator must then decide which of the data entries are correct. Make corrections as needed. Once you have verified that the two spreadsheets are identical, all cells in the difference spreadsheet will display a 0.
Once your data is verified, you should have a data set with an improved level of accuracy than if it had been entered only once. This technique will, of course, not pick up errors that were written down on original documents, or if the same error in data entry was made in both spreadsheets.  

Activity
How can you evaluate the accuracy of spreadsheets? 
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